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Classic Poetry Test Generator continues our test generator series that will allow
teachers to create and store tests based on classical literary works and topics
that teachers will use as part of their class curriculum. More importantly,
however, it will allow teachers to create their test questions once, and then it will
give the teachers the power to instantly generate random, sequential, or a
selected multitude of tests based on the original questions devised. This is
extremely helpful when teachers have a group of classes covering the same
subject area and tests are given to each class — one following the other.

| found that when similar classes take tests sequentially throughout the day (or
on alternate days), some students have a tendency to consult with students who
have previously taken the test. This wouldn’t be so bad if they were really trying
to learn about the subject from the knowledge they acquire, but many of them
simply want a rote summary of the information — answers or questions
memorized in sequence, so they can simply fill in the blanks, regardless of what
they should have learned.

| often felt that it would be a boon to our testing environment if teachers could
generate different versions of the same test, without a lot of work. For example,
it would be helpful if we could take a twenty or thirty question test and quickly put
together four or five variations of this test. Each test would be the same content
for each class but with questions arranged in different orders.

| tried this by hand for a while when | was teaching, and it was amazing how
many students | caught with red faces, when they ultimately realized that the test
wasn’t exactly like the one their friends took yesterday. On a multiple choice test,
for example, some students (in a misguided attempt at helping their mentally
challenged buddies) memorized the sequence of questions and answers. When
the recipients tried using the same sequence of answers (without even reading
the questions) they were stunned at the terrible grades they received. Hopefully
they learned a lesson.

Well, generating a group of tests for the myriad of topics | was covering became
quite a burden, so | decided it would be handy if | had a computer program in
which | could do the following:

e Create collections of these kinds of questions: fill-in, short answer, multiple
choice, open-ended response

e Save these collections of questions as files that | could edit and reuse in
the future.



e Quickly and easily use the files of questions to generate tests with
questions randomly selected from the entire file.

e Quickly and easily use the files of questions to generate tests with
questions randomly selected from selected ranges of questions from the
entire file.

e Quickly and easily use the files of questions to generate tests with
questions | select from the list of question in the entire file.

e In all of the above cases the program should also provide a neatly
formatted list of answers for each of the questions asked.

e Easily create and regenerate multiple variations of multiple choice tests.

Notice that the key words from this list are quickly and easily. Teachers have lots
of work to do, and a lot of this work eats up preparation time. A computer
program that would do this prep work would save a lot of time that could be
better spent on other jobs.

Classic Poetry Test Generator will do the tasks outlined above. In addition, you
can also format your finished tests the way you want them (you can even paste
graphics into the final test you create); save the generated tests in named files,
for use in the future; copy and paste your test information into other documents in
your favorite word processor; search for and insert information in your final tests,
and print hard copies to your printer. Classic Poetry Test Generator even
includes a test editor, so that you can quickly and easily make up your test data
and save it in a format that Classic Poetry Test Generator can import and append
to the current database of questions and answers. We have even included a
simple search puzzle make, too. This is handy for creating search puzzles based
on vocabulary, characters, key terms, etc.

Installing Classic Poetry Test Generator

Installation of Classic Poetry Test Generator is relatively easy. First of all be
aware that this software only runs on Window PC machines. It will not work with
MAC or other types of operating systems. If you received the installation on a
CD, simply insert the CD in drive on your computer. If you have autostart set on
your computer the CD will start up automatically after a few moments of
initialization.

If the installation does not start automatically, simply open My Computer on your
Windows desktop and double click the CD drive icon to open the CD window.
Then double click the setup.exe file to get the installation started.

In both cases above, read the installation screen to complete installation on your
computer. After installation is complete, store your CD in a safe place for backup
use in the future. You won’t need it in the drive to run the program.



If you received your installation via download form the internet, save the file to a
new folder you create on your Windows desktop. You will need WinZip installed
on your computer (available as a free trial download from www.winzip.com) to
unpack Classic Poetry Test Generator installation. If you already have WinZip
installed, double click the file you downloaded and WinZip will give you
instructions to unpack the installation and documentation files to the same folder.
Once this is completed you will have the same files that would be found on the
CD. Simply double click the setup.exe file and follow the screen directions to
install the program on your Windows machine.

Using Classic Poetry Test Generator

Once you have installed Classic Poetry Test Generator on your Windows PC,
you will see a shortcut icon in the Baggetta Ware Literary Test Generator folder,
on the Windows desktop. Double click this with our mouse button and a splash
screen will appear for a few moments. This will be followed by the program’s
main screen, illustrated here.
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information
about the file being used. Just above the text window you will find a format bar,
which will allow you to format text you enter in the text window. This works
similar to most word processors. First you must highlight text in the window
before making changes to the font type, and font size. Most of the time you will
probably not even have a need for these functions, but they are there if you
choose to use them.
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At the top of the screen you will see a menu bar. Here is where you will go for
many of the program’s important functions. Let’s take some time to review the
features of this bar (below it many of the same functions are graphically
represented on a toolbar).

Mews Chr+n The drop-down File menu has the options to start
Open A Test File. .. New, when you want to import or generate a new
B Chries test format. Open A Test File... will allow you to
Save As... open final tests that you have saved. You will only

be able to edit and print these saved tests. Save

and Save As... will allow you to save final

Exdt versions of the tests you create. Print Current
Test will allow you to send the test on display to a

printer you have attached to your computer. Exit is the only legitimate way to

close the program when you are done. Make sure you save any tests you have

created before exiting the program.

Print Current Test  Chrl+P

The drop-down Edit menu allows you to Select
All (contents of the text window). Cut or Copy
Selected Text. Paste Text (in the text window).
Clear Selected Text (from the text window).
Word Wrap text in the text window (This is a
: toggle switch to turn this feature off or on. Itis on
v “Word YWrap OnjOff by default -- checked.). Find Selected Text in
the text window. This feature can be very helpful
in a long test when you want to locate a small
piece of information. These features are grayed out if there is no text in the text
window to be manipulated, as you can see by the illustration here.

Select all Chrla

The Actions drop-down allows you to Make Puzzles
Make Puzzle from the default word list (customizable). Clear (all)
Clear Text Windows text windows. Open the Multiple Choice Test
Generator. Open the Multiple Choice Test Editor.
Open Question Editor (for generating new data files of
Open MC Test Editor questions and answers). Import Your Question List
(data files for use in generating new tests).

Open MC Test Generator

COpen Question Editor
Import Your Question List




The View drop-down menu offers two features.
These are toggle switches again (checkmark

indicates they are on. With these you can turn
the Toolbar and Status Bar on and off screen

v Toolbar Onfioff
v Status Bar  OnfOFF

view.

The Insert drop-down menu allows you to Insert
Date/Time into a selected area of the text window.
Test you generate will have a generic heading on

Insert Date/Time

them.

The Font drop-down menu will allow you to
design the font you want to use in the text
Bold Selected Text Cirl+8 window. You will have to select the text first
[talicize Selected Text  Cirl+] before making a selection from this menu.
Underline Selected Text Crl+U The functions on the toolbar perform these

same actions. Format Font, Bold Selected
Text, Italicize Selected Text, and Underline Selected Text.

Format Font

The Options drop-down offers one option. This is
a toggle switch too, that allows the user to
Preview Font (in the font window) as it will

v Preview Font OnjOFF

actually look if selected.

about The About drop-down will give the user information
about Baggetta_Ware.

The graphic Toolbar does many of the functions, with a few added features,
shown here.
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The center of the main screen contains the control and test information panel. At
the start of the program this panel shows the current database totals.

The control and test information panel is where you will find information about the
current file of questions available. There are three types of tests: Random Tests,
Sequential Tests (plain or randomized), and Selected Questions Tests. If the

Panel shown here is from another test aenerator

Generate Random Test Hows Many Random Questions? (101 Maximum) View Categories
Start With End With # —  Randomize E——

Generate Sequential Test e s i, Sequential Tests of Selected

| Select Topic Here For Quick Sequential Test j Questions

database is divided into categories you will see a “Select Topic...” dropdown list.
From this list you can select categories of questions to generate Sequential or
Randomized Sequential tests. Let’s experiment with a sample test included with
the installation. You can view the available categories in the database by
clicking the View Categories button.

Generating Tests
Okay. Now we are ready to generate a test. Let’'s generate three different test

formats. The first test we will create will be a short quiz of five questions only
(the label indicates
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Gunga Din along with the [what].

click the Generate

(2) [Lady of Shallot] What happened to the mirror that the Lady of Shalott Random Test button.
cried, 'The curse is come upon me.'? |nStant|y you W|”

(3)_ [My Last Duches?] The narrator says that he knl_ms the count is so have a five queStiOI'l
munificent that he will not deny any request for [this]. qUiZ rand0m|y

(4) [Lady of Shallot] How many walls and how many towers ‘overlook a space of SeleCted from the
Fovers™ collected database.

The screen will look
like the illustration
here.
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The interesting feature here is that if you don’t like this combination of questions,
you can just click the Generate Random Test button again to get a different
combination of questions. Also, if you like this combination, but want to type in
additional information or add a graphic to this test you can type in your
information or paste a graphic into the text box. You can also add line spaces to
make more room, if you like. And of course you can use the formatting features
to change other characteristics of the final test. DO NOT add anything, however,
if you plan on using the Generate Random Test button to create another version

of the quiz. Only make changes to the final version you will save or print.

If you scroll down the textbox page, you will find the answers to the questions
you have created for the quiz. These are numbered accordingly. If you plan on
printing from the program, you might want to tap down a few lines (using the
computer Enter key) to make sure that your answers appear on a separate page
for your use as a test key. You wouldn’t want to print these for your students to

use.

Now let’s create, a sequential test, generated with the Generate Sequential
Test button. Let’s say you only want a five question quiz from this file using only
questions 3, 4, 5, 6, and 7 from the file, in that order. To do this first type the
starting question number in the Start With... textbox. The number must be above
0 and below the maximum allowed. We will type a 3 in the box. In the End
With... textbox we’ll type the number of the last question we want and that is the

number 7 question.

After you have done this, click the Generate Sequential Test button to get your
results in the text window. You should get a quiz made up of the five questions
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(Sequential Test)

(1) [Kubla Khan] How many miles did Xanadu encompass?

{2) [Kubla Khan] Xanadu had bright gardens where blossomed many of these
‘incense-bearing' [what].

(3) [Kubla Khan] What is it that strikes the poet as ‘romantic,’' in an ewil
sense?

{4) [Kubla Khan] The poet characterizes the chasm as [this kind] of place.

(5) [Kubla Khan] Out of the chasm there came a mighty [what].
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as they appear in the
original text file
(answers at the
bottom, also), as
illustrated here.

You might want
different versions of
this test (questions 3
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the Randomize
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randomized quizzes of the five questions you opted for. Pretty neat, right?

Sometimes you might just want to pick the questions from the saved file and use
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Check the questions you would like to use in the test.
02 [Kubla Khan] The river Alph runs through caverns down to [what kind
03 [Kubla Khan] How many miles did Xanadu encompass?
04 [Kubla Khan] Xanadu had bright gardens where blossomed many of -
05 [Kubla Khan] What is it that strikes the poet as 'romantic.' in an evil s
06 [Kubla Khan] The poet characterizes the chasm as [this kind] of plac
07 [Kubla Khan] Out of the chasm there came a mighty [what].
08 [Kubla Khan] What is it that are emitted by the fountain and are chare
09 [Kubla Khan] How many miles did the "sacred river' run? v
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or test. Again, using the
same file, let’s create a
quiz of question we
want. We’ll use
questions 2, 5, 6, 7, and
10. To do this we will
use the Selected
Questions button.

When you click the
Selected Questions
button, you will get
another window that will
open on screen. For

Generate A Selected Test |
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like the illustration here.
All of the questions in
your file are listed here
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Cancel Test

to the left of the numbers.

You can select the
questions you want to use
in your selected questions
quiz by clicking the
respective check boxes.
You will be able to scroll
down the window if there
are more questions you
can’t see. When you have
completed your selection,
click the Add Selected
Questions button to place
your selections in the
bottom window. You can
remove question you don’t
want by reversing the
process, using the bottom
window and then clicking
the Remove Questions

has a check box placed
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Check the questions you would like to use in the test.
65 [Gunga Din] Just before he dies. Gunga Din says he hopes the narra ~
71 [Gunga Din] Poetry often rhymes, as does 'Gunga Din.' and patterns
72 [Gunga Din] Kipling uses dialect effects (o' gin and beer, where the r
73 [Gunga Din] How many lines are in each stanza of this unusual poen
74 [Lady of Shallof] What is the name of the mythical city mentioned in t
75 [Lady of Shallot] What is it that 'blow' as the people 'gaze'?

76 [Lady of Shallot] The 'little breezes disk and quiver' through [this] thi
77 [Lady of Shallot] How many walls and how many towers 'overlook a:
78 [Lady of Shallot] ¥hat is it that trail the 'heavy barges'? v

| Add Selected Questions Remove Questions from Selection
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66 [Gunga Din] When is the narrator going to meet Gunga Din?

67 [Gunga Din] The place the narrator will meet Gunga Din is always 'double dr
68 [Gunga Din] The narrator plans to get [this] in Hell, from Gunga Din.

69 [Gunga Din] The narrator ends the poem by saying Gunga Din is a better [wh
70 [Gunga Din] A stanza in poetry is like a full paragraph, with divisions betwee

Generate A Selected Test

Cancel Test




from Selection button.

If you are happy with the questions you have selected, you can then generate
your quiz by clicking the Generate A Selected Test button, located at the bottom
of the screen. If you change your mind about this test altogether, just click the
Cancel Test button to return to the main screen.

After you generate a test (or while you are working on one), be sure to save your
work using the Save (or Save as...) option on the Menu Bar. If you do this you
will assure yourself that you will have these tests to use or edit in the future.

A word about printing. Classic Poetry Test Generator is designed mainly for
creating tests and answer keys that teachers can use for in their classes. You
can print from the program, but we suggest that you use the printout for your use
in making copies of the tests you create. You will want to make sure that the
answer key is not included with the test you copy for your students and it is
generally more economical to use a photocopier to make duplicates for your
class rather than printing an entire class worth of tests from your printer.

Don’t forget too, that you can copy the contents of the text window in this
program and paste the contents into a more elaborate word processor for printing
or formatting.

Generating Search Puzzles
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default list of words. If you don'’t like the structure of the puzzle answers, click
the Revise Puzzle button to get a different version, until you are satisfied.

You can take a look at the default list by clicking the Show Word List button at

¥ Classic Poetry Test Generator

Revise
Puzzle

Click SHOW
PUZZLE to zce
word placement.
Click GENERATE
PUZZLE to show
complete puzzle.
Click REVISE
PUZZLE to make a
new ane. Click
PRINT PUZZLE to
create puzzle and
answer sheet.

Print Puzzle

Exit

{"Hide Ward ™

Classic Poetry Test Generator

HEo Koo E2EHaEEROW
CHOoOONESsSCcybdmiFEHOOEC KSR S

HSnEnaococs w00 RA

EMUHOOTOoOOYdpHHZEZUEOSEOEZ M

OO S HEHZ2RAEBKE Y9N HE D

VITCHXOFWOQTE

T T o M 9 M

W

i = T.

Classic Poetry Test Generator

BALLAD
BURLESQUE
CACOPHONY
CANTO
CONCEIT
COUPLET
DISSONANCE
FABLE
KENNING
LAMENT
LIMERICK
OCTAVE
PALINDRCME
PARADOX

L

W

HEEHHAPFLOLDHRORKPISEQORRD

L T N T | R TR W T R 4

JEKNOVUXGVE

RO o "OHTHRIDEDDOO M

MEHEHEWOZ2HZ22 R R EnAEES

MRS oMb OHRLOE P 20 H

HoHFgHEdAdHEIQODODHD oM Z2HE

4

the bottom of
the screen.
You will get a
scrollable list
to view. You
can close the
list window
by clicking
the Show
Word List
button again.
This also
acts as a
toggle switch
— off and on.

When you
are happy
with the
arrangement
of the
answer
scheme, you
can click the
Generate
Puzzie
button to

construct the final puzzle. Here we show the finished puzzle and the word list on

display.

The final puzzle can be printed from the program or it can be copied and pasted
into a word processor for final printing.



Tot get to the print preview screen, click the Print Puzzle button.

You can't see the

complete page in the
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Close button when
you are finished.

Making Question and Answer Files To Import Into
Classic Poetry Test Generator

You can enhance the power of Classic Poetry Test Generator by creating
additional question files that you can append to the built in database. They are
easy to create and will give you a larger base to generate from.

Questions you originate can be just about any type. Here are some typical
formats:

e Simple fill-in questions. This can be a statement with a blank line that
requires the students to answer with a word or phrase to complete it. It
doesn’t necessarily have to be in the form of a question.

e Multiple choice. The question or statement is presented, followed by three
or four possible choices as answers.

e Short Answer. The question or statement is presented and students must
provide an appropriate short answer.

e Vocabulary. A definition is given that requires a studied word, or vice
versa.



e Problems. A problem is offered and the solution must be given by the
students.

e Open Ended Question. An idea is offered and students must respond with
their solutions. Your acceptable answers might just be suggestions.

When planning the question and answer files you will be using, keep in mind the
following set up format.

You will need a question.
You will need and answer for the question.

There are two ways to make the original files used by Classic Poetry Test
Generator. You can make them manually by using any standard text editor or
word processor that can save files in text format. You can also make them by
using our handy Question Editor that is built into the program menu, under
Actions.

Using A Text Editor or Word Processor

If you create your question and answer file using a text editor (Microsoft Notepad,
for example), open a New document and set Word Wrap on. Type your
information using the following format exactly:

On the first line type the title of your question answer file

On the second line type the number of questions you will have in the file
On the next line type the first question

On the next line type the first answer

On the next line type the second question

On the next line type the second answer

Continue this pattern until you have typed all of your questions and answers.
When you are finished, Save the file as a text file (this is especially important if
you are using a word processor which usually saves as a document file). Some
text editors automatically attach a .txt extender at the end of the file. If this is the
case, after you save your file, locate it using My Computer or Explore and use
the Rename option of Windows to change the extender from .txt to .tga. If you
don’t have this extender on the end of the file name it will not be recognized by
the program

If you want to see how the actual files are constructed open the Sample Generic
Questions.tga file that accompanies the program installation in your text editor
and take a look at it.



Using the Question Editor in Classic Poetry Test Generator
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This add-in program makes file construction easy because you will only be typing
one question and answer at a time. If you want to open our sample file or any
other file you create, use the Open File button. To start a new file, click the New
File button. First you might wan to click on the File Name textbox to type in the
title of your question answer file. Make the name simple and recognizable. After
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SaveFile | |

Question

|ﬂ'he author of 'Cliver Twist' was who? Herman Melville, Mathanial Haw

Anzwer

[Charles Dickens
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you put in the name
you can start creating
the questions and
answers for your file.
Type a question in the
Question textbox and
then tab down to the
Answer textbox to type
the correct or
suggested answer for
this question. Click the
scroll bar at the bottom
of the screen to go to
the next question.

Continue typing
questions and answers
until you are done, and



then click the Save File button to save your question and answer file. We
suggest that you make a new folder with subfolders somewhere on your
computer that will house all of your question and answer files.

If you decide not to use the file you can use Abort Work to stop work on a file
and simply Quit to return to Classic Poetry Test Generator.

APPENDIX I: Multiple Choice Test Generator

The Classic Poetry Test Generator offers the option to create multiple choice
tests. These tests are built differently from the regular questions imported into
the generator so we have a separate add-on program to do the work and also a
special multiple choice editor to help you prepare your lists of questions with
ease.

Before using the Multiple Choice Test Generator you will want to create a list of
questions and answers. Once you have this list of material you can use the
Multiple Choice Test Generator to create many variations on the list. So let's
take a look at the Editor first, to see how it works.

To get to the editor, start Classic Poetry Test Generator and click the Actions
menu at the top of the screen. On the drop down list, click Open MC Test Editor.
It is the fourth option on the dropdown list. You should see the editor appear on
screen and it looks like the image here.

Classic Poetry Test Generator Multiple Choice Test Editor Th 1S lOOkS S mllar

to the regular test

I locoic Postry Teet Cenerstor | edion butit's

refined to accept

Use this editor to create your Multiple Choice Test Editor multiple choice
multiple choice tests or Contrals .
worksheets. You will need to . queStIOHS and
type in a question and four Hew File | | .
pozgible choices. The first Luit pOSSIble answers.

choice should be the comrect |
answer.

Question

| At the top of the

First Angwer [Thig thould be the CORRECT answer) Third Angwer Choice screen 1S the
| | control panel

which will allow

|Second Answer Choice |Foutth Answer Choice you tO start a NEW
FILE, OPEN FILE,

il 2] SAVE FILE,

Enter TITLE of this project 33333 | ABORT FILE’ and

QUIT.

You can see that
there are boxes to type your question and four possible answers — the first
answer will always be the correct answer. This is important, otherwise you
will not get correct results in the answer keys.




At the bottom left there is a scroll bar which you will use to move back and forth
through the questions as you create them, and at the bottom right is a box where
you should enter the title for your test. Keep this reasonably short. Here’s what
the editor looks like when you have completed work on a question or series of

questions and answers.
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Save File | |

Question
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|You can identify the sex of the owner of the woods because the poet says:

Third Answer Choice

His house

Second Answer Choice

[Marie's house

Fourth Answer Choice

|John's house

[T [

Her house

Word #1

Enter TITLE of this project -3333> |5tnping By Woods On A Snowy Evening (Rober Fre

When you have
complete all of
the questions
and answers you
want in this file,
be sure to SAVE
your file with a
unique name that
you will
recognize and in
a location on
your hard drive
or network you
will have access
to. The file will
be automatically
appended with
an .mct extender.

Make sure you have typed only the number of questions and answers you want

to use in the test variations.

Use QUIT to close the Multiple Choice Test Editor when you are through creating
lists of questions and answers.

When you have a multiple
choice file created that you
want to use, you can
create multiple variations
on this database using the
Multiple Choice Test
Generator. Here’s how
you access it. On the
Academic Test Generator
menu, click the Action item
again and from the
dropdown menu this time
select Open MC Test
Generator. This is the
third item on the dropdown
menu. The test generator
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opens and looks like the image here.

Before you can use the Multiple Choice Test Generator (MC), you must open the
file you just created, or some other that you have
stored away. You can easily do this by clicking the
Files menu at the top of the screen and from the
dropdown list select Open Multiple Choice

Close With Save Database. Do not try to open other than an .mct file.

They will not work. If you have a correct file the

menu will close and a red message will appear on screen indicating that your file
is now ready to use.

Cpen Multiple Choice Database

Close With NO Save

At the top of the screen you will notice a control panel with some large buttons
and some option dots.

Seqguential Multiple Choice Test R andom Questionz and Answers Sequential Ouestionsz/F andom &ns.
fs" ‘wWiord Ang, " Letter Ang, fs" ‘wWiord Ang, " Letter Az, fs" ‘Word Ang, " Letter fnz,
Sequential and Random Questions Sequential Quetions
Answers and Answers Random Answers

The control panel has three separate additional panels and each will determine
how your variation of the questions and answers will be set up. In each separate
panel you have the choice of having your answer key displayed as Word
Answers or Letter Answers. Each question will automatically be labeled as A., B.
C., and D., followed by respective answer choices. If you click the Word Answer
dot (the default for each of the panels at the start), your answer keys will be
displayed as a list of words or phrases , each numbered according to the
question it pertains to. If you choose Letter Answer, then the answer key will
only show the correct letter that should have been chosen to answer the
question.

To quickly generate a test or worksheet from any of the panels, click the
corresponding large button for that panel. Here’s what you will get for results
using each button:

Sequential and Answers will give you a test that uses the exact order you
entered the questions and answers in the file you created. But every time you
click the button the order of the questions will vary. It would be most effective to
produce an answer sheet using Word Answers rather than Letter Answers for
this option.

Random Questions and Answers will give you a test that changes the order of
each question in the list and a different order for the answers.




Sequential Questions and Random Answers will give you a test that keeps the
original order of the questions, but changes the order of the answers for each

question.
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1. Thelastline is repeated how many times?

(&) Three (B) If's not repeated at all (C) Two (D) Four

2. What isn't near?
(&) The vilage (B) The road (C) Afire (D) A farmhouse

3. Where is the house?"
{&) The woods (B) By theroad (C) There is no house (D) The village

4. Why does the narrator stop by the woods?
{A) To see the fires burning (B) To hear the harmess bells (C) To see the stars

G:ABW Source Files'a C TestGeneratorshClassic Poetry Test Generator\Stopping By Woods. mct

Close With Save (this is
the third item on the

:“i Classic Poetry Test Generator

File Edit Actions View Insert Font

Options  About

This might seem a bit
confusing at first, but
once you start using
the Multiple Choice
Test Generator, you
will easily become
accustomed to its
features. A completed
test will look like the
illustration here.

If you are satisfied with
the test as it is, you can
now transfer this to the
Main Test Generator
screen for further
modification (different
spacing, add images,
etc.).

You can do this easily
by clicking the Files
menu at the top of the
screen and selecting

dropdown menu. e W& B B U

| dh

If you select Close With
NO save all of your work
on the generated test will
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When you want to save Firedsys Bl

this test to use, click Stopping By Woods On A Snowy Evening (Rober Frost)

Close With Save and your Nane pate

file will be transferred to 1.

The last line is repeated how many times?

A (A) Three (B) It's not repeated at all (C) Two (D) Four
the main test generator ,
2. What isn't near?
Screen’ as Shown here (A) The village (B) The road (C) A fire (D) A farmhouse

3. Where is the house?™
{A) The woods

From here you can now village

modify the file any way 4

you want, even adding

(B} By the road

{C) There is no house (D) The

Why does the narrator stop by the woods?

(A) To see the fires burning (B) To hear the harness bells (C) To
see the stars twinkling (D) To see the woods fill up with snow
5. Fill in the blank "The onlu other sound the ---—-- St
Mat §aved Line:1 Cal:1 11/29/2007 | 8:26 AM 288 KB




graphics, and then print, using the Print option found on the File menu.

If you want to use any of the regular functions of the program you will have to
clear the Multiple Choice test first, using the New option on the File menu.

PROGRAM UPDATES and SUPPORT

As with all Baggetta_Ware products we have tried to keep this software simple to
use and yet functional enough to make it useful. We hope to improve the
program yet and welcome any suggestions you might have. You can forward
them to us through our web page or directly via email at the following address:
baggetta@baggetta.com.

If you encounter any problems with the program, we will try to help you resolve
them as quickly as possible. Please send us email at the above address
detailing the problem. Be sure to include information about your computer
system makeup and any error messages you might encounter. Baggetta Ware
and affiliates are not responsible for any damage caused by unforeseen bugs or
issues to other software and hardware you may be using. Do not use this
software if you cannot agree to these terms.

Copyright -- Questions and answers for our test generators have been devised
by Baggetta Ware and are not to be used for resale or redistribution in any form
without the expressed permission of Baggetta Ware.

You can register your purchase on line at our site www.baggetta.com

A. Baggetta
Baggetta_Ware



